DELCAM Plc

SOFTWARE LICENCE AND TERMS OF SUPPLY

These Terms contain provisions placing obligations on the Licensee and excluding and limiting Delcam’s liability.  The Licensee’s attention is drawn in particular (but not exclusively) to clause 4.3 (Trial Period), 4.4 (deemed acceptance), 5, 6 and 7 (restrictions and obligations on use), 8 (warranties), 9 (limitation of liability) 11 (risk), 12 (indemnity), 13 (termination), 21 (law and jurisdiction) and addendum (dongle insurance).

1 
Definitions and interpretation 

1.1 
In these Terms, unless the context otherwise requires, the following expressions have the following meanings:

1.1.1
“Delcam” means Delcam plc, Talbot Way, Small Heath Business Park, Birmingham B10 0HJ, UK.

1.1.2
“Delivery Date” means the date of delivery of the Licensed Program Materials to the Licensee.

1.1.3
“Designated Equipment” means computer equipment that provides the minimum operating environment for the Licenced Program as specified in the Program Documentation and which is connected to the Licence Control System.

1.1.4 “Hardware Lock” means an electronic hardware lock (sometimes referred to as a dongle) whose identity is encoded in the PAF and is required for the operation of the Licence Control System.

1.1.5 “Licence” means the licence granted by Delcam to the Licensee under clause 2.1 the type of which will be Full, Demonstration or Academic as designated by the PAF. Any Licensed Program designated as “Evaluation” in a PAF shall be treated as Demonstration for the purposes of these Terms.

1.1.6 “Licence Control System” means the electronic means of authorising the Use of the Licenced Program on the Designated Equipment pursuant to the Licence.  The operation of the Licence Control System is controlled by the PAF.  In the case of a fixed licence the Licence Control System will require a Hardware Lock to be fitted to the Designated Equipment.  In the case of a floating licence the Licence Control System requires the Designated Equipment to be in constant network communication with a Licence Server.  The Licence Control System will be configured by Delcam to enforce the conditions of the Licence purchased by the Licensee, which may include fixed or floating licence, limits on concurrent executions, absolute limit on the number of executions or transactions, time period limits.

1.1.7 “Licence Fee” means the fee for the Licence specified by or on behalf of Delcam.

1.1.8 “Licence Server” means a computer program supplied by Delcam as part of the Licence Control System for the purpose of allowing a floating licence to be allocated to any instance of Designated Equipment on the same computer network as the Licence Server.  The Licence Server must be installed on a suitable computer processor fitted with a Hardware Lock. 

1.1.9 “Licensed Program” means the software program or programs in object code form specified in the PAF.

1.1.10 “Licensed Program Materials” means the Licensed Program, the Hardware  Lock and the Program Documentation.

1.1.11 “Licensee” means the person, firm, company or other organisation to whom Delcam licences the Licensed Program Materials pursuant to these Terms.

1.1.12 “PAF” means a data file or files issued by Delcam to enable the Licensed Program and the Licence Control System supplied by Delcam to be executed on Designated Equipment in accordance with the purchased functionality.

1.1.13 “Program Documentation” means any Program Specification, instruction manuals, user guides and other information relating to the Licensed Program supplied by Delcam to the Licensee in paper or electronic form. Program Documentation is written in English which shall take precedence and any translation of the Program Documentation into another language which may be supplied for information shall not be regarded as definitive. 

1.1.14 “Program Specification” means the technical specifications from time to time published by Delcam in respect of the Licensed Program.

1.1.15 “Registered Users” means the set or sets of specified user identities that are permitted to Use the Licensed Program.  The number of members allowed in the set or sets may be limited by the PAF but the Licensee may change user identities at will.

1.1.16 “Restricted Mode” means a version of the Licensed Program which contains the restrictions on functionality set out in Schedule A.

1.1.17 “Site” means the address specified by the Licensee and identified in the PAF for delivery of the Licensed Program Materials.

1.1.18 “Terms” means the terms and conditions set out in this document and any document referred to herein.

1.1.19 “Trial Period” means the period of 30 days commencing on the Delivery Date   during which the Licensee can evaluate the Licensed Program free of charge in accordance with clause 4.2. 

1.1.20 “Use” means the copying or transmission of the Licensed Program into the Designated Equipment and the processing of the instructions contained in the Licensed Program and “Used” shall be construed accordingly.

1.2
In the construction of these Terms, (except where the context otherwise requires):

1.2.1
Contents and headings: contents and headings appear for convenience and do not affect the construction of the whole or any part of these Terms;

1.2.2
Currency: a reference to any monetary amount is to the currency of the United Kingdom which at the date of these Terms is pounds sterling (GBP) but following any introduction of Economic Monetary Union in the United Kingdom shall mean the euro after converting amounts of pounds sterling into euros according to law;

1.2.3
English legal terms: a reference to an English legal term for any action, remedy, method of judicial proceeding, legal document, legal status, court, official or any other legal concept or thing shall, in respect of any jurisdiction other than England, be deemed to include a reference to what most nearly approximates in that jurisdiction to the English legal term;

1.2.4
Rights of third parties: except where expressly stated nothing in these Terms is intended to confer upon any third party any rights whether under the Contracts (Rights of Third Parties) Act 1999 or otherwise;

1.2.5
Schedules: a reference to a schedule is to a schedule to these Terms and any such schedule shall form part of these Terms;

1.2.6
Statutes and regulations: a reference to a statute includes any regulation or order made under that statute. Reference to a statute or regulation or order is a reference to the statute or regulation or order as amended or substituted.

2
Grant of Licence

2.1 Subject to clause 2.2 Delcam in consideration of the payment by the Licensee of the Licence Fee grants to the Licensee a non-exclusive licence to Use the Licensed Program upon the Designated Equipment with the number of concurrent executions and/or concurrent transactions and/or Registered Users controlled by the Licence Control System and to possess and refer to the Program Documentation subject to these Terms provided that:

2.1.1 in the case of a fixed licence the Licensed Program Materials shall remain at and shall be Used at the Site save that temporary Use for home-working or off-Site working by individuals normally based at the Site will be permitted; 

2.1.2 in the case of a floating licence the Licence Server shall be located and remain at the Site. 

2.2 The Licensed Program may be operated in Restricted Mode if no Licence Control System is found when the Licensed Program starts up. If in such circumstances  the Licensee wishes to operate the Licensed Program in Restricted Mode only then:

2.2.1 the Licensee shall not be required to pay the Licence Fee in accordance with clause 3;

2.2.2 the Licensed Program will contain the restrictions on functionality listed in Schedule A (“the Restricted Functionality”);

2.2.3 if the Licensee wishes to access the Restricted Functionality it may either:

(a) (if it requires access to the Restricted Functionality listed in Schedule A as available via pay-per-use only) purchase a pay-per-use voucher from Delcam’s website which will permit the Licensee to access the Restricted Functionality listed in Schedule A as available via pay-per-use; or

(b) notify Delcam that it wishes to upgrade the Licensed Program to include the Restricted Functionality which it may do upon payment of the Licence Fee to Delcam;

2.2.4 if the Licensee shall use any third party product in conjunction with the Licensed Program to replace the Restricted Functionality it shall be immediately liable to pay the Licence Fee to Delcam;

2.2.5 clauses 4 and 7 of these Terms shall not apply if the Licenced Program is operated in Restricted Mode;

2.2.6 if the Licensee elects to upgrade the Licensed Program to include the Restricted Functionality in accordance with clause 2.2.3 the Trial Period shall not apply to the upgraded Licensed Program.

The Licensee acknowledges that where it operates the Licensed Program in Restricted Mode it is not required to pay the Licence Fee and that accordingly the restrictions on functionality listed in Schedule A are reasonable. The Licensee further acknowledges that it has the rights to access the Restricted Functionality set out in clause 2.2.3.

2.3 The number of concurrent executions and/or concurrent transactions and/or Registered Users will be limited by the PAF and may not be altered without the prior written consent of Delcam.  As a condition of granting such consent Delcam will be entitled to make a reasonable charge.

2.4 The Licensed Program may be operated on behalf of the Licensee by a facilities manager of good standing and integrity the same to be approved by Delcam and these Terms shall be interpreted accordingly.

2.5 The Licensee shall be responsible for any defaults of its facilities manager in observing these Terms and shall at all times indemnify Delcam accordingly.

2.6 The Licensed Program may not be:

2.6.1 Used for the operation of any timesharing bureau or similar activity for the benefit of third parties; nor

2.6.2 the subject of any patent or patent application or any other form of application or registration for intellectual property protection.

2.7 Where the Licence is designated by the PAF as an Academic Licence the Licensed Program and Licensed Program Materials may be used only for the purposes of teaching and research and shall not be used for any commercial purposes or for commercial gain.  If any Licensed Program and/or Licensed Program Materials subject to an Academic Licence shall be used for commercial purposes or for commercial gain the Licensee shall immediately become liable to pay to Delcam the balance of the Licence Fee for a Full Licence.

2.8 For the avoidance of doubt any Licence Server and/or any Designated Equipment which requires a Hardware Lock for its Use may only be Used at the Site save for the limited exception referred to in sub-clause 2.1.1.

2.9 
The Licensee shall supply Delcam with required registration information and agrees that Delcam may provide the Licensee’s name and addresses to its licensors.
3 
Licence Fee 


Unless the Licence has been terminated in accordance with clause 4.3 or the Licensee will operate the Licensed Program in Restricted Mode only, the Licensee will pay the Licence Fee to Delcam direct or via its authorised sales partner at the end of the Trial Period in the manner agreed between Delcam or Delcam’s authorised sales partner on behalf of Delcam and the Licensee. Delcam may use the Licence Control System to restrict access and to prevent the Use of the Licensed Program until such time as the specified Licence Fee has been paid.

4
Delivery, Installation and Acceptance

4.1
Delcam or its authorised sales partner will deliver to the Site one copy of each of the Licensed Program (including the Licence Control System) and Program Documentation, the PAF and the number of Hardware Locks corresponding to the Licence.  Any time stated for delivery is indicative only and time shall not be of the essence or capable of being made of the essence.

4.2
The Licensee will install the Licensed Program on the Designated Equipment at the Site and will be entitled free of charge for a period of 30 days commencing with the Delivery Date to Use the Licensed Program not for the purpose of its trade or business but solely for the purpose of assessing whether the same meets its requirements.  During this period the Licence will be a Demonstration Licence.

4.3
If during the Trial Period the Licensee decides that the Licensed Program Materials do not meet its requirements then the Licensee shall be entitled to terminate the Licence forthwith by written  notice to Delcam such notice to be given not later than the end of the Trial Period.

4.4
If the Licensee does not terminate the Licence by notice pursuant to clause 4.3 above or if during the Trial Period it shall Use the Licensed Program for the purposes of its trade or business then (in either case) the Licensee will be deemed to have accepted the Licensed Program Materials upon these Terms and the Licence Fee shall become immediately due and payable.  The Licence will on payment of the Licence Fee be converted to a Full Licence or Academic Licence as appropriate.

5 
Confidentiality 

5.1
The Licensed Program Materials contain confidential information of Delcam and its licensors. Delcam or its licensor is the owner or licensee of all intellectual property rights forming part of the Products and Program Documentation (including the Trade Marks). 

5.2
The Licensee shall not:

5.2.1
except as provided in clause 6 make back-up copies of the Licensed Program Materials;

5.2.2
reverse engineer, decompile, disassemble, copy or adapt the whole or any part of the Licensed Program Materials for the purposes of correcting errors in the Licensed Program Materials;

5.2.3 modify or make works derivative of the Licensed Program Materials;
5.2.4 except solely for the purposes expressly permitted by and in accordance with Section 296A(1) or Section 50C(2) Copyright, Designs and Patents Act 1988 copy, adapt or, reverse compile, reverse engineer, decompile or disassemble the whole or any part of the Licensed Program Materials;

5.2.5 assign, (save in accordance with clause 7)  transfer, sell, lease, rent, charge or otherwise deal in or encumber the Licensed Program Materials or use the Licensed Program Materials on behalf of any third party or make available the same to any third party;

5.2.6 remove or alter any copyright or other proprietary notice on any of the Licensed Program Materials.

5.3
The Licensee shall:

5.3.1 
keep confidential the Licensed Program Materials and limit access to the same to those of its employees, agents and sub-contractors who either have a need to know or who are engaged in the Use of the Licensed Program in accordance with the Licence;

5.3.2
reproduce on any copy (whether machine readable or human readable form) of the Licensed Program Materials Delcam’s copyright,  trade mark and other proprietary notices;

5.3.3
maintain an up to date written record of the number of copies of the Licensed Program Materials and their location and upon request forthwith produce such record to Delcam;

5.3.4
notify Delcam immediately if the Licensee becomes aware of any loss of or unauthorised use of the whole or any part of the Licensed Program Materials by any third party;

5.3.5
without prejudice to the foregoing take all such other steps as shall from time to time be necessary to protect the confidential information and intellectual property rights of Delcam and its licensors in the Licensed Program Materials.

5.4
The Licensee shall inform all relevant employees, agents and sub-contractors that the Licensed Program Materials constitute confidential information of Delcam and its licensors, and that all intellectual property rights therein are the property of Delcam or its licensor and the Licensee shall take all such steps as shall be necessary to ensure compliance by its employees, agents and sub-contractors with the provisions of this clause 5 and the terms of the Licence.

6 
Copying of the Licensed Program Materials

6.1
The Licensee shall be entitled to make back up copies of the Licensed Program for disaster recovery purposes. Any such copy shall in all respects be subject to these Terms and will be deemed to form part of the Licensed Program.

6.2
The Licensee shall not be entitled to copy in whole or in part the Program Documentation except for the Licensee’s personal use only in accordance with the Licence.  Further copies of the Program Documentation are available on request from Delcam at its then prevailing rates or by accessing the same in electronic format from such electronic media or website as may be notified by Delcam from time to time and where downloaded and/or printed any such copies shall be for the Licensee’s personal use only in accordance with the Licence.

6.3
The Licensee shall be entitled to download patches for the Licensed Program from Delcam’s website and is advised to check that website regularly for the latest patches and advice in relation to the Licensed Program.  For the avoidance of doubt new versions of the Licensed Program are only available to a Licensee who also has a current maintenance agreement with Delcam or its authorised representative.

7
Transfer of the Licensed Program Materials

7.1 The Licensee may request the transfer of the Licensed Program to alternative Designated Equipment requiring the issue of a new PAF. Delcam shall be entitled to attach such conditions to the granting of such consent as it may in its absolute discretion reasonably consider appropriate including a condition that Delcam will be entitled to make a reasonable charge.

7.2 For the avoidance of doubt the warranty by Delcam in clause 8.3 and any support services supplied in respect of the Licensed Program which are the subject of any separate agreement with Delcam or its authorised sales partner will only be supplied to the Site to the holder of the Hardware Lock.  This includes floating licences unless any separate arrangements are expressly agreed by Delcam.

8 
Warranties 

8.1
Subject to the exceptions set out in clause 8.4 and the limitations upon its liability in clause 9 Delcam warrants that:

8.1.1
its title to any property in the Licensed Program Materials is free and unencumbered and that it has the right, power and authority to license the same upon these Terms;

8.1.2
the media upon which the Licensed Program Materials are supplied will for a period of 90 days from the Delivery Date be free from defects in materials, design and workmanship;

8.1.3
the Licensed Program will for a period of 90 days from the Delivery Date conform to the Program Specification;

8.1.4
the Hardware Lock will for a period of 90 days from the Delivery Date be free of defects.

In no event may the Licensee bring any claim, action or proceeding arising out of the warranty set out in this clause 8.1 more than one year after the date on which the breach of warranty occurred
8.2
The Licensee shall give notice to Delcam as soon as it is reasonably able upon becoming aware of a breach of warranty.

8.3
Subject to clause 8.4 Delcam will use its reasonable endeavours to remedy any breach of the warranties set out in clauses 8.1.2, 8.1.3 and 8.1.4 free of charge by diagnosing the fault and using its reasonable endeavours to rectify the fault (remotely or by attendance on Site as determined by Delcam), by the issue of replacements in respect of defective media or Hardware Lock or of fixes in respect of the Licensed Program and the making of all necessary consequential amendments (if any) to the Program Documentation. Any such replacements will be warranted for the remainder of the original warranty period or 30 days from the date of receipt by Licensee, whichever is longer.

8.4
Delcam shall have no liability to remedy a breach of warranty where such breach arises during or as a result of:

8.4.1
accident or the improper use, operation, or neglect of either the Licensed Program Materials or the Designated Equipment; or

8.4.2
the modification of the Licensed Program or its  merger (in whole or in part) with any other software not provided by Delcam or not intended for combination with the Licensed Program; or

8.4.3
the Use of the Licensed Program on equipment other than the Designated Equipment; or

8.4.4
the failure by the Licensee to implement recommendations in respect of or solutions to faults  previously published by Delcam on its website; or 

8.4.5
any repair, adjustment, alteration or modification of the Licensed Program or Hardware Key or acts or omissions by any person other than Delcam without Delcam’s prior written consent; or 

8.4.6
any breach by the Licensee of any of its obligations under any maintenance agreement in respect of the Designated Equipment; or

8.4.7
the use of the Licensed Program or Hardware Lock for a purpose for which  they were not designed; or

8.4.8
the transfer or Use of the Licensed Program Materials in breach of clause 7.1; or
8.4.9 
the operation of the Licence Program in Restricted Mode; or
8.4.10
Use of the Licensed Program during any Trial Period.
8.5
Without prejudice to the foregoing Delcam does not warrant that the Use of the Licensed Program will meet the Licensee’s data processing requirements or any specific purpose or that the operation of the Licensed Programs will be uninterrupted or error free.

8.6
Subject to the foregoing all conditions, warranties, terms and undertakings express or implied statutory or otherwise in respect of the Licensed Program Materials are hereby excluded by Delcam and its licensors to the fullest extent permitted by law including (without limitation) the implied conditions, warranties or other terms as to satisfactory quality, fitness for purpose and the use of reasonable care and skill.

9
Limitation and exclusion of liability 


THE LICENSEE’S ATTENTION IS EXPRESSLY DRAWN TO THE PROVISIONS OF THIS CLAUSE 9.

9.1
Liability for:


9.1.1
death or personal injury caused by negligence; or

9.1.2 liability under Part 1 of the Consumer Protection Act 1987; or

9.1.3
fraudulent misrepresentation;



is not excluded or limited. 

9.2
Subject to the following provisions of this clause 9 or to any other express provisions relating to liability contained in these Terms the liability of Delcam or that of any members of the same group of companies to which Delcam belongs or that of Delcam’s licensors and for its or their employees, agents, distributors or sub-contractors for any act or default in relation to these Terms whether in contract, tort (including negligence), strict liability or otherwise shall be limited to:

9.2.1 
the amount of single event cover in Delcam’s public or product liability insurance (whichever may be applicable) in force at the time the loss or damage occurs for loss or damage to tangible property; or 

9.2.2 
in the case of all other liability the aggregate of the sum of 9.2.2.1 and 9.2.2.2 where:

9.2.2.1  
is the whole or any part of the Licence Fee paid in respect of the subject matter giving rise to the liability and which is held to be subject to repayment by Delcam; and

9.2.2.2
is the amount 20% of the Licence Fee or GBP1,000 (whichever is the greater).

9.3
No liability shall attach for any loss (or associated expenses) in the nature of:  


9.3.1
loss of profits, loss of revenue, loss of production, loss of data or loss of use;



9.3.2
loss of goodwill or reputation;



9.3.3
third party claims; 

9.3.4
indirect, special or consequential losses as generally understood   under English law;

whether foreseeable or otherwise and whether or not Delcam had been made aware of the possibility of the same arising. Subject to the aforesaid and to the limitations in clause 9.2, Delcam accepts liability for direct losses as generally understood under English law.

9.4
Save in respect of: 

9.4.1   
liabilities described in clause 9.1; or

9.4.2
liability for loss or damage to tangible property; or

9.4.3
liability under clause 10 (intellectual property rights indemnity);

no liability for damages shall arise until such time as the Licensee has given Delcam written notice to remedy the default in accordance with any particular clause of these Terms and failed to do so or, in any other case, having been given written notice to remedy the default (if remediable) and Delcam  has failed to do so within a period of thirty (30) days.

9.5
Delcam will not be liable to the Licensee for loss arising from or in connection with any representation, agreement, statement or undertaking made before the parties entered into the contract on these Terms  other than those representations, agreements, statements or undertakings confirmed by duly authorised representatives of Delcam  in writing or expressly incorporated or referred to in these Terms. THE LICENSEE EXPRESSLY REPRESENTS THAT IT IS NOT RELYING UPON (AND THEREFORE SHALL HAVE NO REMEDY IN RESPECT OF) ANY SUCH REPRESENTATION, AGREEMENT, STATEMENT OR UNDERTAKING OTHER THAN AS EXPRESSLY SET OUT OR REFERRED TO IN THESE TERMS. These Terms  constitute the whole agreement and understanding of the parties as to their subject matter and there are no terms, conditions, warranties or obligations whether oral or written, express or implied, whether by statute or common law, other than those contained in or referred to in these Terms. Nothing in these Terms shall limit Delcam’s liability for fraudulent misrepresentation.

9.6
The Licensee accepts that the Licensed Program Materials were not designed and produced to its individual requirements or for any specific purpose or purposes of the Licensee and that it was responsible for their selection and accordingly Delcam shall not be liable to the Licensee if the Licensed Program Materials are not fit for the Licensee’s purposes.

9.7
Advice or assistance provided by Delcam or its group companies, agents or representatives relating to any aspect of the Licensed Program (whether provided before, during or after delivery) including (but not limited to) operational usage or potential applications is given for the Licensee’s sole assessment and decision (if necessary after trial operations by the Licensee) having regard to the Licensee’s own particular circumstances.  Accordingly such advice or assistance is given without responsibility or liability.

9.8
The Licensee accepts that the Licensed Program is supplied as a tool which is constantly being developed and that the Licensee is solely responsible for the way in which the Licensed Program Materials are Used and for any product data design or other output resulting from the Licensee’s Use of the Licensed Program Materials including their Use and the consequences of such Use in conjunction with any other software or equipment or product. Without prejudice to the foregoing obligation in accordance with best industry practice the Licensee shall at each stage verify data which is input into and produced from the Licensed Program Materials.

9.9
Without prejudice to its obligations under clause 11 of these Terms the Licensee recognises the Licensed Program will not function without the Hardware Lock and consequently the importance of ensuring its safekeeping at all times during the term of the Licence.

9.10
Delcam is concerned to ensure that the Licence Fee for the Licensed Program Materials remains competitive and taking into account:

9.10.1
the fact that the Licensee is in a better position than Delcam  to know or ascertain the amount of any loss which will arise out of any defect in the Licensed Program Materials;

9.10.2 the fact that the extent of the damage that might be caused or alleged to be caused to the Licensee is disproportionate to the amount that can reasonably be charged (and is charged) by Delcam  to the Licensee;

9.10.3 the terms and conditions upon which Delcam’s  own suppliers are prepared to supply goods and services to Delcam;

this must necessarily involve the incorporation of the provisions of this clause 9.

10 
Intellectual Property Rights indemnity

10.1
Delcam  will indemnify and hold harmless the Licensee against any damages (including costs) that may be awarded or agreed to be paid to any third party in respect of any claim or action that the normal operation, possession or use of the Licensed Program Materials by the Licensee infringes the patent, copyright, registered design or trade mark rights of the said third party (an “Intellectual Property Infringement”), provided that the Licensee:

10.1.1
gives notice to Delcam  of any Intellectual Property Infringement immediately upon becoming aware of it; and 

10.1.2
gives Delcam the sole conduct of the defence to any claim or action in respect of any Intellectual Property Infringement and does not at any time admit liability or otherwise settle or compromise or attempt to settle or compromise the claim or action except upon the express instructions of Delcam; and

10.1.3
acts in accordance with the reasonable instructions of Delcam and gives to Delcam  such assistance as it reasonably requires in respect of the conduct of the defence.

For the avoidance of doubt the indemnity in this clause 10.1 covers only infringements of the type referred to which are caused by or directly attributable to the Licensed Program Materials themselves and excludes infringements of the rights of a third party caused by the application of the Licensed Program Materials by the Licensee whether in any design or manufacturing process or otherwise.

10.2
Delcam will reimburse the Licensee its reasonable costs incurred in complying with the provisions of clause 10.1 above.

10.3
Delcam will have no liability to the Licensee in respect of an Intellectual Property Infringement if it results from any breach of the Licensee’s obligations under these Terms.

10.4
In the event of an Intellectual Property Infringement Delcam will be entitled at its own expense and option either to:

10.4.1
procure the right for the Licensee to continue using the Licensed Program Materials; or

10.4.2
make such alteration, modification or adjustment to the Licensed Program Materials so that they become non-infringing without incurring a material diminution in function; or 

10.4.3
replace the Licensed Program Materials with non-infringing substitutes provided that the substitutes do not entail a material diminution in function.

10.5
The limitation of liability in clause 9.3 shall not apply to this indemnity.

11
Risk in the Licensed Program Materials

11.1
Risk in the Licensed Program Materials will pass to the Licensee following delivery.  If subsequently the Licensed Program Materials are destroyed, damaged,  lost or stolen, Delcam  will upon request as soon as reasonably practicable replace them subject to the Licensee paying its then prevailing charges.

11.2 Without prejudice to the provisions of clause 11.1, the Licensee shall take such steps as may be necessary in respect of any matters arising out of or relating to its possession and Use of the Licensed Program to the extent at least to which Delcam excludes or limits its liability in respect of the same pursuant to these Terms including where appropriate obtaining insurance cover.  The Licensee is also expressly referred to Delcam’s policy statement with regard to Hardware Locks (dongles) which appears in the addendum at the end of (but which forms part of) these Terms.

12 Indemnity by Licensee 


The Licensee shall indemnify and keep Delcam  indemnified from and against any liability of any kind to any third party howsoever arising (whether in contract, tort  or otherwise and including, but not limited to, liability arising from the negligence of Licensee  or from the negligence of any person for whom Licensee  is vicariously liable) in respect of or in connection with:

12.1 any defect in the Licensed Program Materials; and/or

12.2   
any loss, injury or damage of any kind (whether direct, indirect or otherwise and including but not limited to any loss of profit and/or any incidental, consequential or special loss or damage of any description) arising out of in respect of or in connection with the installation or supply of the Licensed Program Materials or their Use;


except to the extent that Delcam  has expressly assumed liability under these Terms for the loss, injury or damage concerned.

13
Termination

13.1
The Licence will continue until terminated in accordance with the provisions of clause 13.2 below.

13.2
The Licence may be terminated:

13.2.1
without prejudice to the provisions of clause 4.3 by the Licensee upon giving not less than 30 days’ notice in writing to Delcam;

13.2.2 
forthwith by Delcam  if the Licensee fails to pay any monies due under these Terms  within 30 days of the due date;

13.2.3
forthwith by either party if the other commits any material breach of any of these Terms  (other than one falling within clause 13.2.2 above) and which (in the case of a breach capable of being remedied) shall not have been remedied within 14 days of a written request to remedy it;

13.2.4
forthwith by either party if the other convenes a meeting of its creditors or if a proposal is made for a voluntary arrangement within Part 1 of the Insolvency Act 1986 or a proposal for any other composition, scheme or arrangement with (or assignment for the benefit of) its creditors or if the other shall be unable to pay its debts within the meaning of Section 123 of the Insolvency Act 1986 or if a trustee, receiver, administrative receiver or similar officer is appointed in respect of all or any part of the business or assets of the other or the making of any arrangement with its creditors by the other or the imposition of an administration order or if a notice of intention to appoint an administrator order or if a notice of intention to appoint an administrator is given by the other party or its directors or by a qualifying floating charge holder (as defined in paragraph 14 of Schedule B1 to the Insolvency Act 1986 (as inserted by section 248 of the Enterprise Act 2002)) or if a petition is presented or a meeting is convened for the purpose of considering a resolution or other steps are taken for the winding up of the other or for the making of an administration order (otherwise than for the purposes of an amalgamation or reconstruction);

13.2.5
by Delcam if the Licensee loses its Hardware Lock or if the Licensee’s Hardware Lock is stolen. 

13.3
Any termination of the Licence will be without prejudice to any other rights or remedies to which a party may be entitled under these Terms or at law and will not affect any accrued rights or liabilities of either party nor the coming into or continuance in force of any provision which is expressly or by implication intended to come into or continue in force on or after such termination.

13.4
Within 10 days of the termination of the Licence (irrespective of the reason for termination), the Licensee will at Delcam’s sole option either return all copies of the Licensed Program Materials in its possession or control or destroy all copies of the Licensed Program Materials in its possession or control and a duly authorised officer of the Licensee shall certify in writing to Delcam that the Licensee has complied with its obligation under this clause 13.4.

14
Force majeure 

14.1
Neither party will be liable for any breach of its obligations under these Terms   resulting from causes beyond its reasonable control (an “Event of Force Majeure”).

14.2
Each of the parties agrees to give notice to the other upon becoming aware of an Event of Force Majeure, such notice to contain details of the circumstances giving rise to the Event of Force Majeure.

14.3
If a default due to an Event of Force Majeure continues for more than 4 weeks, then the party not in default will be entitled to terminate the Licence. Without prejudice to the provisions of clauses 13.3 and 13.4 neither party will have any liability to the other in respect of the termination of the Licence as a result of an Event of Force Majeure. 

15
Waiver 


The waiver by either party of a breach or default of any of these Terms   by the other party will not be construed as a waiver of any succeeding breach of the same or any other provision nor shall any delay or omission on the part of either party to exercise or avail itself of any right power or privilege that it has or may have under these Terms operate as a waiver of any breach or default by the other party.

16
Notices 


Any notice, request, instruction or other document to be given under these Terms   will be delivered in person or by first class registered post (airmail if overseas) or by facsimile transmission to the address or to the facsimile number of the other party and any such notice or other document will be deemed to have been served (if delivered personally) at the time of delivery, (if sent by post) upon the expiration of 2 business days after posting (5 business days if overseas) and (if sent by facsimile transmission) upon the expiration of 2 hours after  receipt of a report of satisfactory transmission if before 3.00pm on a business day (local time to the addressee) otherwise at 10.00am on the next business day (local time to the addressee). For the purposes of this clause 16 a “business day” shall exclude Saturdays, Sundays and public holidays. Service by facsimile shall only be valid if a confirmatory letter is despatched no later than the next available business day in the place of transmission. 

17
Invalidity and severability  


If any provision of these Terms is found by any court or administrative body to be invalid or unenforceable, the invalidity or unenforceability of such provision will not affect the other provisions of these Terms and all provisions not affected by such invalidity or unenforceability will remain in full force and effect. The parties agree to attempt to substitute for any invalid or unenforceable provision a valid or enforceable provision which achieves to the greatest extent possible the economic, legal and commercial objectives of the invalid or unenforceable provision.

18
Assignment and sub-licensing 


The Licensee shall not be entitled to assign or otherwise transfer these Terms nor any of its rights and obligations under these Terms nor sub-license the use (in whole or in part) of the Licensed Program Materials without the prior written consent of Delcam.

19       Technology transfer restrictions


The Licensed Program Materials and any relevant technical information or documentation in relation thereto may not be imported or transferred in any way which would breach any technology transfer restrictions imposed by the United States, the United Kingdom or any other national or supranational authority.  

20
Language


If these Terms or any part thereof are translated into any language other than the original English language version the English language text shall in any event prevail. 
21
Law and jurisdiction 

21.1
These Terms will be governed by and construed in accordance with English law and the parties agree subject to clause 21.2 to submit to the exclusive jurisdiction of the English courts. The Licensee hereby irrevocably waives any right to claim the application of any alternative law or jurisdiction.

21.2
The submission by Delcam and the Licensee to such jurisdiction shall not however limit the right of Delcam to commence any proceedings arising out of these Terms in any other jurisdiction it may consider appropriate.

Addendum

Delcam policy statement with regard to Hardware Locks (dongles) – November 2004

Dongle insurance is advised by Delcam for all Licensees. Delcam's policy is that a Hardware Lock (dongle) will be replaced when stolen or lost subject to availability and at Delcam’s then current list price for the Hardware Lock and Licensed Program attached.  This will be subject to and without prejudice to Delcam’s right of termination in accordance with clause 13.2.5.  However if Delcam in its absolute discretion agrees to replace the Hardware Lock and Licensed Program on such terms a new PAF will be issued under the present Licence.  It is therefore the responsibility of the Licensee at its sole discretion to insure the dongle and attached Licensed Program or Licensed Programs with the hardware.  

Major insurance companies, such as General Accident, Commercial Union or Royal Sun Alliance offer insurance for the dongle as part of the hardware system, but dongles cannot be insured on their own. If the hardware is stolen or lost with the dongle attached, the whole system (hardware and software) would be replaced by the insurance company in accordance with the terms of the policy. A typical premium is 1.55% of the total solution value. Such a policy is available in most countries - certainly by these named British companies, but also by some local insurance companies in other territories. However, it is clear that the dongle cannot be insured on its own so if a Licensee loses his dongle or the dongle only is stolen, then it will not be covered by the insurance policy.  

For further information on this and available insurance schemes the Licensee should consult with Delcam’s authorised sales partner for the territory in which the Site is located.

This information is given in good faith by Delcam at the date stated above but the Licensee is responsible for seeking advice relevant to its own particular circumstances from its insurance advisors. Delcam shall not be accountable for any reliance placed by the Licensee on this statement nor any consequences of the Licensee so doing.

Schedule A

	Product
	Functionality in full version
	Restrictions in Restricted Mode
	Functionality available via Pay-Per-Use?

	PowerSHAPE (Restricted Mode/Pay-Per-Use Mode is called PowerSHAPE-e)
	Printing of drawings (File->Print)
	Only available via PRINT SCREEN button in Windows – not via File->Print in PowerSHAPE
	No

	
	Creation of non-watermarked ray-traced images

(View->Render)
	All ray-traced images are watermarked with the Delcam logo in the bottom right hand corner
	No

	
	Export of files
(File->Export)
	Export of files is only available via Pay-Per-Use Mode
	Yes

	PS-Exchange
	Export of files
	Export of files is only available via Pay-Per-Use Mode
	Yes


Note: Any software product not listed in the above table will not execute in Restricted Mode
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